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Introduction to Embarcadero DBArtisan   

DBArtisan is an industry-leading database administration solution for managing Oracle, Microsoft SQL Server, 
Sybase Adaptive Server, IBM DB2 for Windows, Unix, and Linux, IBM DB2 for OS/390 and z/OS databases, and 
MySQL. Its cross-platform capability allows users to efficiently manage heterogeneous database platforms easily 
using a single front-end tool. Using DBArtisan, users boost their productivity by using a single tool for all their 
databases, regardless of vendor.   

Product Benefits   
DBArtisan provides benefits to the following functions: 

 

Database Administrator  DBArtisan enables database administrators to accomplish more with the time 
they have available in their workday. It eliminates the tedious tasks associated 
with researching schema dependencies when making object changes. Also 
included are a host of utilities, which condense DBA tasks taking hours or 
days down to minutes.   

Developer DBArtisan provides additional administration functionality to database 
developers over standard development platforms. Using the powerful schema 
extraction, schema migration, and publication wizards, developers can quickly 
extract and move schema from development to other environments, as well as 
create objects much quicker than using old-fashioned hand coding techniques. 

 

About This Guide  
This evaluation guide is intended to help you get started using Embarcadero’s DBArtisan, the industry-leading 
solution for administering enterprise databases from a single point of control. While DBArtisan supports current 
versions of Oracle, Microsoft SQL Server, Sybase Adaptive Server, IBM DB2 for Unix, Windows, and Linux, IBM 
DB2 for OS/390 and z/OS, and MySQL, the examples in this guide are Oracle-centric. Unless otherwise noted, all 
features and functionality highlighted in this guide are applicable to all supported platforms.  

After reviewing this evaluation guide, you will have the foundation you need to explore the many features and 
benefits of DBArtisan. You’ll have learned how to competently manage the major database administration 
disciplines using DBArtisan’s standard cross-platform console. In addition, you will have a solid understanding of 
DBArtisan’s more advanced Space, Performance, and Capacity management capabilities.   

This guide is divided into 10 sessions:   

Session 1: Getting Started with DBArtisan  

Session 2: Schema Management  

Session 3: Security Management  

Session 4: Space Management  

Session 5: SQL Management  

Session 6: Job Management  

Session 7: Data Management  

Session 8: Performance Management  

Session 9: Capacity Management  

Session 10: General Utilities and Tools  

  

You can use this basic tutorial as a roadmap of product highlights, but also to help you find your own path to 
explore DBArtisan.   
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Once you’ve started, you can select Help from the toolbar to find many additional resources that complement and 
build on many of the activities shown in this brief guide.  
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Session 1: Getting Started with DBArtisan  

Download and Install  
You can obtain the latest version of the DBArtisan software from the Embarcadero website at 
http://www.embarcadero.com/downloads/downloaddbartisan.jsp. 

Provide the requested information and follow the steps indicated to download and install the software. When you 
first install an evaluation copy of DBArtisan, you can use the tool for 14 days. After that time, a permanent license 
is needed.   

Introduction to Embarcadero DBArtisan   
DBArtisan is an industry-leading database administration solution for managing Oracle, Microsoft SQL Server, 
Sybase Adaptive Server, MySQL, IBM DB2 for Windows, Unix, and Linux, and IBM DB2 for OS/390 and z/OS 
databases. Its cross-platform capability allows users to efficiently manage heterogeneous database platforms 
easily using a single front-end tool.  Using DBArtisan, users boost their productivity by utilizing a single tool for all 
their databases, regardless of vendor.   

Overview  
The graphic below illustrates all the elements of the DBArtisan User Interface:   

 
 

   

Start DBArtisan      
1. On the Start menu, point to Programs, Embarcadero DBArtisan 8.5.0, and then select DBArtisan.  

The first time DBArtisan starts, it displays a message indicating that it can automatically detect and register 
your datasources.  If you have installed and used other Embarcadero tools, DBArtisan can find any active 
datasources being used by those tools.  In addition, DBArtisan provides a Discover Datasources feature that 
automatically searches the DBMS configuration files on your system for datasources that are not currently 
registered. The Discover Datasource feature is a dialog box that contains a list that includes the name of the 
server or instance and the type of DBMS, of all unregistered datasources found on your network or local 
machine, including the name of the server or instance and the type of DBMS. Once discovered, you have the 

Right pane of Explorer
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option to register datasources for DBArtisan usage. 

2. For the purpose of this Guide, dismiss the dialog.  You will be registering a datasource manually.  

 

Registering Cross-Platform Datasources  
The Datasource Registration Wizard walks you through the process of registering a datasource for use with 
DBArtisan..  

1. On the Datasource menu, select Register Datasource. 

DBArtisan opens the wizard, initially prompting you for the DBMS type.  

   
2. Select Oracle as the database type and then click Next.  

DBArtisan opens the next panel of the Datasource Registration Wizard. 

 
 

3. Provide the Host machine name associated with an Oracle datasource.  

4. Type a Port number. The default is 1521, but you can change it to wherever the Oracle listener is set up. 

5. Specify a Type of SERVICE_NAME or SID and enter the corresponding value in the SID/Service Name box. 

6. In the Datasource Name text box, type SAMPLE_DATASOURCE for the purpose of this example.  

7. Click Next.  

DBArtisan saves your selections and opens the next panel of the Datasource Registration Wizard.  
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8. In User Id, type the user id for the database.   

9. In Password, type the user’s password.  

10. To save and encrypt your password, select Auto-Connect?   

11. Click Next.  

DBArtisan opens the final panel of the wizard. 

 
 
12. In the Managed Datasources tree, place the datasource you are registering.   

13. Click Finish.  

DBArtisan prompts you as to whether you want to connect to the datasource. 

14. Click Yes.  

 
DBArtisan offers the same easy-to-use Datasource Registration Wizard for IBM DB2, Microsoft SQL Server, 
Oracle, MySQL, and Sybase connections. The connection information only needs to be set up one time for each 
datasource and can be saved locally or in a common datasource catalog for use by other Embarcadero products.  

You can configure Embarcadero database applications to use a datasource catalog stored in the system registry 
of your machine (local) or to use a datasource catalog located in the registry of another computer (remote). This 
capability makes it easy to share datasource catalogs among multiple users so that maintenance can occur in one 
location.   

All Embarcadero database administration products share the datasource catalog, which means that when you set 
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up your datasource catalog using one product such as DBArtisan, the same list of datasources is available in 
other Embarcadero Technologies products. Any changes you make to the datasource catalog are reflected in all 
Embarcadero database management products.  

General Usability Features  
DBArtisan provides many “user in mind” features that make the product configurable to meet individual needs and 
preferences.  These features are designed to shave time off the tasks that you perform many times on any given 
working day.    

Retaining Datasource Explorer View Settings  

1. At the top of the Explorer tree, click to expand the drop-down menu.  

2. Select Retain View Settings.  

 

   
The next time you open DBArtisan, the Explorer appears just as you left it. All connections that were present 
when you closed DBArtisan will be reestablished.  

Datasource Explorer Bookmarks   

1. In the Explorer tree, right-click any node.  

2. Select Add Bookmark.  

 



DBArtisan 8.5 Evaluation Guide 

 11  

 

   
 

DBArtisan opens the Add Friendly Bookmark Name dialog box.   

3. Click OK.   

 
After Bookmarks are defined you can use them to easily navigate to commonly used datasource resources via the 
main menu Bookmarks item.       

   

 
Setting Keyboard Shortcuts and Hotkeys  

1. In any open space above the Datasource Explorer, right-click.  

DBArtisan opens a shortcut menu.  

2. From the shortcut menu, select Customize.  

The Customize dialog box opens.  

3. In the Customize dialog box, open the Keyboard tab.    

 

   
The Keyboard tab can be used to set Keyboard shortcut hot keys for all areas of DBArtisan functionality.  

4. Click Close.    
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Referencing Most Recently Used Datasources  

1. From the File menu, select Recent Datasources, and then choose a datasource.     

DBArtisan opens the datasource in the Datasource Explorer, ready to work with an active connection.  
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Session 2: Object and Schema Management  

Advanced Object Creation and Management  
DBArtisan provides unparalleled database object management capabilities.  Its database platform- and version-
specific graphical object editors and wizards enable you to easily create, drop or alter any of your accessible 
database objects.  The following example walks you through creating and then altering a standard Oracle table 
object.  This concept carries across all of the supported object types, across all of the supported platforms.   

Creating a Table Object  
1. On the Datasource Explorer, expand the Schema node an Oracle datasource.  

2. On the Oracle datasource, right-click the Tables node, and then select New.  

DBArtisan opens the Table wizard and leads you through the process of creating a table object.  

 

   
3. Complete the wizard panels, and ensure that you create two or more columns in the table.  

4. Click Finish.  

DBArtisan lets you preview any and all generated scripts before you submit them to the database. This is 
standard for all object related scripts.   

 

Making changes to an existing table object  
Changes to database tables, such as modifying column lengths, inserting new columns, or deleting unneeded 
ones, can require dropping of a table. This requires knowledge of the underlying object dependencies so that 
these dependent objects are rebuilt after the table has been re-created. DBArtisan provides the ability to perform 
“extended” table alterations by constructing a SQL script with the steps necessary to save off the original data, 
create the new table, and populate it with the original data. Once these steps are complete, all dependent objects 
are then rebuilt and permissions re-applied. Following is a sample table change:  

1. From the Explorer, Tables node, select the table you created in the previous example.  

2. Double-click the table.   

 
OR  

3. From the Command menu, click Open.  

DBArtisan opens the Table Editor. The Table Editor provides access to basic table properties, the list of 
table columns as well as any constraints, storage parameters, space allocation, partitioning, table 
dependencies, object privileges, table DDL and other attributes of the table.  
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4. Click the Columns tab. 

5. Select one of the columns you created in this table you want to modify.  

Details for the column are shown in the Column Attributes area on the right side of the pane.  

 

   
6. In the Width or Scale text box, type a new value.   

7. On the Tables Editor toolbar, select the Alter button.  

DBArtisan lets you preview the SQL script before you submit it to the database.  

 
8. Close the Tables Editor pane.  

Working with Object DDL  
DBArtisan allows you to easily extract DDL for single or multiple objects using several methods.  The most 
straight-forward is described here:  

1. On the Explorer, expand an Oracle datasource.  

2. On the Oracle datasource, click the Tables node.    

3. In the right pane of the Explorer window, right-click any table or group of tables (SHIFT+CLICK), and then 
select Extract.  

The DDL for all highlighted objects is extracted directly in a DDL Editor where it can be altered, executed and 
saved to the database, with no intermediary steps required.  

 

   
4. Close the PL/SQL Editor pane.  

Advanced Schema Management  
In addition to standardized object support, DBArtisan provides you with advanced Schema 
management features. These features include full or object-level schema extraction, migration (with or 
without data) and publication. This example walks you through a simple cross-platform migration 
between Oracle and SQL Server datasources. Because DBArtisan automatically resolves differences 
between these disparate DBMS platforms, you can concentrate on what you want to do, rather than 



DBArtisan 8.5 Evaluation Guide 

 15  

 

how to actually do it. The Schema Migration Wizard sequences the creation of objects in the proper 
order to eliminate dependency errors. It also has the intelligence to use the fastest method available 
for copying table data.  
Schema Level Migration  

While this example focuses on schema migration, the same wizard principle applies to schema extract and 
publication.  

1. On the Utilities menu, select Schema Migration.  

DBArtisan opens the Migration Wizard.  

2. Click Next. 

DBArtisan opens the second panel of the Schema Migration Wizard.  

 
 

3. Select Perform New Migration and Normal mode on this panel.  

4. Click Next. 

 DBArtisan opens the third panel of the Migration Wizard. 
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5. Under Source Datasource, select an Oracle datasource.   

6. Under Target datasource, select an SQL Server datasource.  

7. Click Next.  

DBArtisan opens the next panel of the Migration Wizard.  

 

   

 
8. Use the Server Objects and Database Object Types boxes to select the owner (All owners is the default) 

and associated object types you want to migrate to the target datasource.     

9. Click Next.  

DBArtisan opens the next panel of the Migration Wizard.  

 
 
10. In the Migration Options box, specify the migration options to use for this migration job. This panel provides 

a comprehensive list of dependency, script, and ownership options. 

11. Click Next.  

DBArtisan opens the next panel of the Migration Wizard.  
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This panel provides a summary of the migration about to be performed. 

At this point you can either click Next to view the progress of the migration or click Cancel to quit. 
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Session 3: Database Security Management  

DBArtisan can help you efficiently establish and maintain database security and related objects.  
Whether you are managing an existing production database or setting up a new environment, you’ll 
find consistent support across all of the supported platforms.  

Adding a new database user  
While this example focuses on creating a new Oracle user, the same wizard-driven principle applies to all security 
objects (groups, roles, etc).  

1. On the Datasource Explorer, expand an Oracle datasource, and then the Security node.  

2. On the Security node, right-click Users, and then click New.  

DBArtisan opens the User Wizard and leads you through the process of adding a user.  

 

   
3. Provide the information on each panel of the User Wizard until you reach the DDL View panel.  

DBArtisan allows you to preview any and all generated scripts before they are submitted to the database. 
This is standard for all object related scripts.  

5. Click Execute to create the new user.  

DBArtisan opens the User Editor for the new user. The standard User Editor can be used to manage 
existing database users as shown below.  

 

Granting and Editing User Privileges   
Privileges can be easily granted, revoked, or viewed from within either of two editors within DBArtisan; the User 
Editor, or the individual object editor (Table, procedure, etc.)  The User editor provides a tabbed interface, which 
can be used to view and modify individual attributes of the user.   

1. In the User Editor, open the Object Permissions tab.  

2. Use the Object Type dropdown to select a set of objects such as tables or views.  
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3. Select a cell (corresponding to a specific object type and a specific permission, such as DELETE), and then 

click Grant.  

A distinctive icon is shown in the cell, indicating that this permission is granted. You use a similar process to 
revoke privileges and perform other permissions-based activities.  

4. On the Object Editor toolbar, click Alter to implement the changes.  
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Session 4: Space Management  

Managing space is vital to ensuring the availability and performance of your databases. DBArtisan incorporates 
many built-in space features that enable you to smartly manage and exploit all aspects of your database’s 
storage. The following example walks you through a review of DBArtisan’s built-in support for reporting Oracle 
tablespace storage and space data.  

Built-in Space Management  
While this example is specific to Oracle tablespaces the same concept applies to all of the supported platforms.  

1. On the Datasource Explorer, expand any Oracle datasource.  

2. On the Oracle datasource, expand the Storage node, and then select Tablespaces.  

3. Right-click any tablespace listed in the right pane of the Explorer window, and then click Open.  

Embarcadero DBArtisan opens the Tablespaces Editor.   

4. On the Tablespaces Editor, click the Storage tab.  

The Storage tab displays and lets you edit the tablespace extent limits.   

 
 

Changes to this tab enable the Alter function on the Tablespace Editor toolbar.  

5. On the Tablespace Editor, click the Space tab. 

The Space tab displays a graphical view of the Free space and Fragmentation Index for the target 
tablespace.  

  
   

6. Finally, on the Tablespace Editor, click the Map tab.  
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The Map tab displays a color-coded map of the objects contained on the tablespace.  

  

   
 

The map segments are proportional to the actual size of the objects on the tablespace.  

7. Close the Tablespaces Editor pane. 

Advanced Space Management (Oracle and SQL Server only)  
For advanced space analysis and management, DBArtisan’s optional Space Analyst component contains 
sophisticated diagnostics to help you pinpoint all space-related problems in your database, as well as an 
intelligent reorganization wizard that can reorganize all or selected parts of your database.  

Embarcadero Space Analyst   

 
1. On the Analyst menu, select Space Analyst.  

The Space Analyst launches in the DBArtisan workspace.    
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Embarcadero’s Space Analyst provides sophisticated diagnostic capabilities to troubleshoot bottlenecks and 
performance inefficiencies that result in poor space management.  

Please see the DBArtisan online help for a detailed walkthrough of all available features and functionality.  

2. Close the Space Analyst pane. 
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Session 5: SQL Management  

DBArtisan provides powerful visual tools for creating and analyzing complex SQL statements and server-side 
code objects.  The following examples walk you through DBArtisan’s Visual Query Builder, feature-rich ISQL 
facility and some of the advanced analysis and debugging capabilities provided by the Embarcadero SQL 
Debugger and SQL Profiler.  

Visual Query Builder   
1. From the Tools menu, select Query Builder.  

 
OR  

2. In the right pane, right-click a table, and then select Build Query.  

DBArtisan opens the Query Builder.  

 

   
3. In the Tables/Views tab, right-click a table or view and select Add. 

4. In the window that opens, select the columns to return in the result.  

Query Builder generates the query text in the lower SQL window.  You can build advanced queries using the 
options supplied in the DML tab.   You choose the type of query (SELECT, INSERT, and so on) using the 
dropdown on the Query Builder toolbar. 

5. After the query is built, click the Execute button (green arrow) on the Query Builder toolbar.   

Query Builder displays results in the lower SQL window.  

6. Close the QueryBuilder pane. 
 

ISQL Window  
1. On the File menu, click New, and then ISQL.  

DBArtisan opens the ISQL Editor window.  
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2. Add SQL code via your method of choice (free-form typing, retrieve from a file, paste copied code, etc.).  

 
The ISQL Editor window includes the following features and options:  

• The ISQL window highlights all platform and general keywords and provides the options for SQL code 
formatting, syntax checking and analysis.  

• Once code is executed you have control over whether your transaction is committed or rolled back from 
the database.  

• For all open ISQL windows, there are also options for connection locking, scheduling, executing your 
code across multiple datasources, explain plan generation, and SQL Tuning.  

 
3. Press F8 prior to SQL execution.  

DBArtisan opens the Query Option dialog box that lets you set platform specific Query Options to 
immediately determine if your code is optimized.  

 

   
4. Either close the Query options dialog and then the SQL Editor window or continue to work to execute your 

query.  When complete, ensure that only the Datasource Explorer window is open.  

SQL Debugging, Analysis and Tuning  
To analyze and debug your SQL code, DBArtisan provides cross-platform SQL code debuggers, and for your 
Oracle databases, a robust PL/SQL code profiler that helps you to pinpoint and eliminate “hot spots” within poorly 
running server-side code.  To ensure code efficiency, the ISQL window provides tight integration with 
Embarcadero’s SQL Tuner, so you can perform multiple “test then tune” iterations without having to leave an 
open ISQL window.  
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SQL Debugging  
While this example is specific to Oracle PL/SQL Debugging the same interface and functionality applies to all of 
the supported platforms.  

1. On the Datasource Explorer, expand any Oracle datasource node.  

2. On the Oracle datasource, expand the Procedures node.   

3. In the right pane of the Explorer, right-click any stored procedure, and then select Debug.  

 

   
4. If applicable, enter any input parameters the Procedure Execution input window and then click Continue.  

 
After the SQL Debugger interface is displayed you can step through code, step into dependencies, set and watch 
variables, and even perform basic code profiling for each line of executed code.  

Please see the DBArtisan online help for a detailed listing of all available SQL features.  
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Session 6: Job Management  

DBArtisan freely integrates with the Microsoft Windows Task Scheduler, which allows you to schedule virtually 
any task to run on your own computer whenever and how often you’d like.  While this example is specific to an 
Oracle table redefinition, the same concept applies to any job or script that can be scheduled.  

Advanced Job Management  
To schedule a job, do the following:  

1. On the Explorer, expand any Oracle datasource.   

2. On the Oracle datasource, expand the Tables node, and then right-click any table.   

3. Select Extract.  

   
4. From the ISQL window toolbar, click Schedule.  

 
 

The Scheduler Action dialog box opens where you can provide a name, set notifications, and specify an 
output directory for the new job.  

  
5. After you have completed the dialog box, click OK.  

6. To monitor and administer your new job, on the Oracle datasource, right-click the Instance node, and then 
select Job Scheduler.  

This opens the Windows Job Scheduler dialog.  For the purposes of this exercise, you can either finish scheduling 
the task and inspect the results when it completes, or you can click Cancel to proceed to the next session. 
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Session 7: Data Management  

DBArtisan provides comprehensive facilities to help you manage the data in all of your databases.  A visual data 
editor helps you add, change, and delete data from your tables with all referential integrity enforced.  You can 
create insert statements for tables using current data and also extract data as XML documents for certain 
databases.  Rounding out its rich Schema Management capabilities, DBArtisan also allows you to migrate 
schema objects and associated table data from one database server to another, across the same or different 
platforms.  

Visual Data Editing   
To start the Visual Data Editor, do the following:  

1. In the Datasource Explorer, right-click any table or tables, and select Edit Data.   

DBArtisan opens the Data Editor Filter.  

2. In Columns, select the columns to include in the Edit.  

 

   
3. You can also filter the editable rows by including your own Select statement.  

4. Click OK.  

In Live mode all changes are applied to the database when you move off of an updated or inserted row. 
Deleted rows are immediately removed from the database.  

Batch mode allows you to make changes and then save all when all are complete. Mode is controlled by a 
dropdown in the Data Editor toolbar.  

5. Experiment with editing your data, and when complete, on the Data Editor toolbar, click the Execute (blue 
arrow) button.   

DBArtisan commits your changes. Regardless of mode, all of the generated DML statements are viewable in 
the lower SQL window.  

 

   
6. Close the Data Editor pane. 
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Working with Table Data – Create Insert Statements   
1. On the Datasource Explorer, select any Oracle datasource.  

2. On the Oracle datasource, expand the Tables node.   

3. In the right pane of the Explorer window, right-click any table, and then select Create Insert Statements.   

DBArtisan opens the Create Insert Statements dialog box.  

 

   
5. In Columns, select the columns you want to include in the Insert statement.   

6. You can also filter what rows are included by adding your own Select statement.   

7. OPTIONAL Select Owner information and row limit   

8. Click OK.  

The resulting insert statements are created and presented in an active ISQL window. At this point they can 
be executed immediately, scheduled to later or saved. Note that all extracted insert statements can be run 
against the same or different databases containing a similar schema.  

 

   
9. Close the editor pane. 
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Working with Table Data – Extract Data as XML  
This feature is available for Oracle 9i and SQL Server 8.1. The following example is specific to Oracle 9i, but the 
concept applies to SQL Server 8.1 as well.  

1. On the Datasource Explorer, expand any Oracle datasource.  

2. On the Oracle datasource, expand the Tables node.   

3. In the right pane of the Explorer window, right-click any table listed, and then select Extract Data as XML.   

4. Select the columns to include in the Insert statement.   

5. You can also filter what rows are included by adding your own Select statement.   

6. Click OK.  

The resulting XML document is created and presented in an active XML Editor. At this point the document 
can be saved in XML format.  

 

   
7. Close the editor pane. 

Advanced Data Management – Schema and Data Migration   
DBArtisan provides advanced data management tools that help you to move schema and corresponding table 
data across the same or different platforms.  You can copy a single database object, all objects owned by a 
specific user, or an entire database all guided by a wizard-driven process.  

Schema and Data Migration  

While this example is specific to an Oracle to SQL Server schema and data migration the same concept applies 
to any migration involving any combination of the supported platforms.  

To open the Schema Migration Wizard:  

1. On the Utilities menu, select Schema Migration button.   

DBArtisan opens the Migration Wizard.  

2. Click Next.  

DBArtisan opens the next panel of the Migration Wizard.   
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3. Select the Perform new migration and Normal Mode options. 
 
4. Click Next.  

DBArtisan opens the next panel of the Migration Wizard.   

 
5. Select Oracle server and database as the Source Datasource and a Microsoft SQL Server server and 

database as the Target Datasource .   

6. Click Next.  

DBArtisan opens the next panel of the Migration Wizard.   
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7. Select the objects to be migrated to the target datasource.   

8. Select which owner to transfer objects for.  

9. Specify the migration options to use for this migration job.  

10. Select the Customize Object List option.  

11. Click Next.  

DBArtisan opens the next panel of the Migration Wizard.   

 

   
12. Select the specific objects you would like to migrate.   

13. Click Next.  

DBArtisan opens the next panel of the Migration Wizard.   
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14. Select the Dependency, Script, Owner, Table, and Migration options to be used while performing the  

migration.   

15. Click Next.  

DBArtisan opens the next panel of the Migration Wizard. It procices a summary of your choices and 
provides additional options. 

 

   
Clicking Finish executes the migration and lets you view the progress of the job. 
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Session 8: Performance Management  

DBArtisan offers a number of different options to help you manage the performance of your databases.  First, 
DBArtisan ships with a built-in process monitor that helps you understand who is connected to your database 
along with each user’s current activity and session-related data.  For more robust performance details DBArtisan’s 
Performance Analyst add-on is a powerful client-side database monitor that runs fully contained in the DBArtisan 
console.  

Monitoring Sessions   
While this example is specific to Oracle the Process Monitor is available for all of the supported platforms.  

To start the DBArtisan Process Monitor:  

1. On the Datasource Explorer, select any Oracle datasource.   

2. From the Utilities menu, select Database Monitor.    

 

   
The Database Monitor includes the following options and features:  

• Highlight any session and any currently running SQL is displayed in the lower pane.  

• You can drill-down into a specific session to display session-level statistical details, historical and current 
wait events along with a working copy of the currently running SQL that can be copied to an ISQL for 
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explain plan generation.   

• By using the Monitor drop down options you can display more advanced database-level monitoring data 
such as locks, blocking locks, hit ratio by user, Top 20 SQL etc.  

 

   
3. Close the Database Monitor pane. 

Advanced Client-Side Performance Monitoring   
For advanced performance monitoring and management, DBArtisan’s optional Performance Analyst provides 
intelligent diagnostic information and strong drilldown details to help you get to the heart of any episode of 
performance degradation.  Performance Analyst integrates completely with DBArtisan so you can fix any 
performance problems with a few clicks of the mouse.  

As of DBArtisan 8.5, Performance Analyst is available for Oracle, SQL Server, Sybase and DB2 for Unix, 
Windows, and Linux on Open Systems.  

Embarcadero Performance Analyst   

1. On the Datasource Explorer, select any Oracle datasource.  

2. On the Analyst menu, select Performance Analyst.  

The Performance Analyst opens in the DBArtisan workspace for the target datasource.   
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Please see the DBArtisan online help for a detailed walkthrough of all available features and functionality.  

For enterprise performance monitoring, DBArtisan integrates with the Embarcadero Performance Center Web 
Client. While integration requires a licensed Performance Center server, there are not upgrade requirements for 
the DBArtisan console.  

NOTE: You should only work through the following exercise if you are a current Performance Center user.  If you 
are not a Performance Center customer, please read the following for information purposes only. 

Use the following to establish a quick connection to your Performance Center server:  

1. On the Options Editor, select the Perf Center tab.  

 

   
2. Select the Web Client radio button and enter the Performance Center server info as indicated. Perform a test 

to ensure the configuration is correct. After a connection is established you can use the Tools > Performance 
Center option to launch the Web Client within the DBArtisan console. If you are using the full Performance 
Center client you can use this same Options editor tab to switch back.  
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Note the Performance Center web client provides read only access to the monitored datasources. To perform 
edits or maintenance you must switch to the full Performance Center client.  

Please see the DBArtisan online help for a detailed walkthrough of all available features and functionality.  
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Session 9: Capacity Management  

Planning for the future of your critical databases used to be a difficult task. However, DBArtisan’s optional 
Capacity Analyst tool makes it easy to understand where your databases are today and where they are headed in 
the future. Capacity Analyst lets you track key database metadata and performance metrics over time so you can 
perform trend analysis on key are like growth, object fragmentation, I/O and session load.  Like all of the Analyst 
Series products, Capacity Analyst runs fully contained within DBArtisan so you have access to smart, built-in 
forecasting mechanisms that allow you to predict when your databases will run out of space and the ability to 
proactively manage your storage assets, all from the same console.  

As of DBArtisan 8.5, Performance Analyst is available for DB2 for Unix, Windows, and Linux, Sybase, Oracle, and 
SQL Server.  

Advanced Capacity Planning – Embarcadero Capacity Analyst   

1. On the Datasource Explorer, select any Oracle datasource.  

2. From the Analyst toolbar    click the Capacity Analyst button.  

The Capacity Analyst opens in the DBArtisan workspace for the target Oracle datasource.   

 
 

   
Please see the Embarcadero Capacity Analyst evaluation guide for a detailed walkthrough of all available 
features and functionality.  
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Session 10: General Utilities and Tools  

No evaluation of DBArtisan would be complete without a mention of the general Utilities and Tools that are 
available across all of the supported platforms.  

Utilities Menu  
The main toolbar Utilities menu contains the more advanced DBArtisan features. The available menu items are 
context-sensitive and version specific for the selected datasource DBMS platform. This example shows Utilities 
menu features that are available for Oracle.  

   

Tools Menu  
The main toolbar Tools menu contains those features that are common across all dbms platforms. This example 
shows the Tools menu features that are available for all supported dbms platforms.  Note that if any other 
Embarcadero products are installed on your client they will be available in the Tools menu.  

   
All DBArtisan utilities and tools provide a common interface that walks you through all input and execution 
requirements. All results are consistently presented so you can easily move between features without effort or 
confusion.  
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Additional Resources 

Licensing Your Embarcadero Technologies Product 
All Embarcadero Technologies products include a 14-day trial period. To continue using the product 
without interruption, we recommend that you license it as soon as possible. To license your product, 
use the License Request Wizard found in the Help menu of your respective product. If you have not 
yet purchased your Embarcadero Technologies product, contact sales@embarcadero.com, or 
uk.sales@embarcadero.com for sales in the EMEA region. 

Embarcadero Technologies Product Support 
The Embarcadero Technologies Web site is an excellent source for additional product information, 
including white papers, articles, FAQs, discussion groups, and the Embarcadero Knowledge Base. Go 
to www.embarcadero.com/resources, or click any of the links below, to find: 

• Documentation 

• Online Demos 

• Technical Papers 

• Discussion Groups 

• Knowledge Base 

• FAQ 

Embarcadero Technologies Technical Support 
If you have a valid maintenance contract with Embarcadero Technologies, the Embarcadero Technical 
Support team is available to assist you with any problems you have with our applications. Our 
maintenance contract also entitles registered users of Embarcadero Technologies products to 
download free software upgrades during the active contract period. Evaluators receive free technical 
support for the term of their evaluation (14 days). 

We encourage you to open technical support cases via the Technical Support request form at the 
Embarcadero Technologies Web site. For additional information about Embarcadero Technologies 
Technical Support, go to the Support page on our Web site. 

Embarcadero Technologies on the Web 
To download evaluations of other Embarcadero Technologies products or to learn more about our 
company and our products visit us at www.embarcadero.com. 


